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Overview
Outpost Packet Message Manager

What is Outpost?
• A Windows-based packet messaging client

• Supports ARES, RACES, and other amateur radio emergency response
teams and their need to pass digital traffic

• Helps automate the packet message handling environment

• Manages all message-handling between you and the BBS

• Lets you read, delete, create, reply to, or forward messages back to the BBS
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Overview
Outpost Packet Message Manager

Why use Outpost?
• Leverages the existing packet hardware, network, and BBS 

infrastructure
• Uses your existing TNC and packet radio equipment
• Compatible with many existing BBSs and TNC PBBSs
• Only your packet client (end-user program) changes

• Hides the complexity of the packet operating environment
• Similar look and feel to contemporary email programs
• Shorter learning curve for packet operations
• Allows users to… “focus on the message, not the medium”

• Implements most local emergency management policies for digital 
communications

• Still under active development based on user requests and on-going 
alignment with the Outpost mission
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Overview
Outpost Packet Message Manager

Mission

The Outpost Packet Message Manager program supports the 
Emergency Communications Packet User community with a 
contemporary amateur radio packet messaging client that allows 
users to focus on the message, and not the medium.

Goal

Help get local ARES/RACES teams on the air with digital 
messaging using their existing hardware and BBS infrastructure.
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Overview
Outpost Packet Message Manager

Feature highlights
• Message support

• supports Private, NTS, and Bulletin messages
• text formatting in a free-form message window
• NTS Message Maker with an ARL message wizard
• On-line report builder

• Send/Receive Session (connection) control
• supports Serial, AGWPE, and Telnet interfacing with over 20 PBBS and BBSs
• controls connecting, sending messages to and retrieving messages from the BBS

• Configurations and Setups
• BBS, TNC, and Interface configurations
• message type and retrieval options
• supports 3 ways for automatically initiating send/receive sessions
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Overview
Outpost Packet Message Manager

Message support
• Familiar email-app look & feel
• Separate folders for message 

storage
• Clear message identification 

(unread=BOLD, urgent=Red)
• Formal message workflow
• BBS and interface setups
• Additional settings control 

how Outpost behaves
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Overview
Outpost Packet Message Manager

Creating Messages
• Supports Private, Bulletin, 

and NTS message types
• Message formatting before 

sending
• Set messages to Urgent
• Request delivery or read 

receipts
• Different ways for originating 

messages
• NTS Message Maker
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Overview
Outpost Packet Message Manager

Viewing messages
• Supports viewing, printing, 

deleting or saving a message 
to a local file

• Reply and Forward message 
formatting
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1. Acknowledge Read, send automatically
2. Create a message
3. Forwarding/Replying to a message
4. KA-Node/Netrom (BPQ) Access
5. Message annunciation
6. Message numbering
7. Message receipts
8. Online reports
9. Printing messages automatically
10. Retrieving messages automatically
11. Retrieving selected bulletins
12. Sending a text file
13. Setting up a BBS
14. Setting up a BBS, Santa Clara County RACES
15. Setting up a TNC
16. Setting up AGWPE
17. Setting up Telnet access
18. Signature, adding to a message
19. Tactical Calls
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Overview
Outpost Packet Message Manager

Types of controls
• Controls the flow of Send/Receive Sessions 
• Sets how messages are created and handled
• Set various data fields to automatically 

populate on-line reports and messages
• Set up default Directory Names
• Various Log Settings
• Form sizing Controls
• Separate Interactive Packet Windows for… 

• Serial TNCs
• AGWPE
• Telnet
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Overview 
Outpost Packet Message Manager

Send/Receive Settings
• Selects different ways to automate the 

message send/retrieve sessions

• Select which message types are to be 
retrieved

• What to do with received messages

• Additional controls manage 
printing messages 
(Other Tab) 
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Overview 
Outpost Packet Message Manager

Message Settings
• Settings for new messages, includes

• Default destinations
• Auto message numbering
• Add a Signature

• Handling replies and forwards 

• Set defaults for requesting 
message receipts

• Setting for permanently deleting 
messages 
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Overview 
Outpost Packet Message Manager

Report Settings
• Message number automatically 

increments and populates…
• Subject Line
• NTS Messages
• On-line reports

• Standard report variables automatically 
replace <tags> in On-line Reports 
(described later)

• Note where tags are used…
Field On-Line

Reports
NTS

Message 
Maker

Message
Subject 

Line
Next Message Number X X X
Organization X
City X X
County X
State/Prov X X
Tactical Location X
Tactical ID X X
Tactical TX Text X
Text Variable #2, 3 X



What’s new since EmCommWest’06?
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v2.2   6-April-2007    

•Telpac support

•Enhanced BBS support

•Auto-BBS prompt detect 

• Improved message readability

•Warning notifications

•21 other enhancements and defect 
changes

v2.1  7-October-2006

•Tactical Calls

•BBS Access through KA-Node, 
Netrom

•Add Message signature

•Expanded message printing

•19 other enhancements and defect 
changes

All release details are up at www.outpostpm.org
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v2.2 Telpac/Winlink
Outpost Packet Message Manager

Telpac/Winlink
• Supports internet email 

addressing

• Multiple destinations

• Supports Reply-to-all for 
multi-destination addressed 
messages

• Handles multiple addresses
to non-Telpac BBSs

• No support for attachments
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v2.2 Enhanced BBS Support  
Outpost Packet Message Manager

BBS setups
• BBSs

•BBS Name
•BBS Prompts
•BBS Commands
•BBS Path

Notes...
• Auto-identifies the BBS by reading 

the SID
• Knows of or figures out the BBS 

Prompts
• Special handling for non-

identifying BBSs
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v2.2 Enhanced BBS Support  
Current list of supported BBSs (26-April-2007)

PBBSs (Firmware-based, 
TNC resident)

BBSs (Software-
based)

Support requested 
and pending

KPC3, KPC3+
KPC9612
KAM, KAM-XL, KAM-98, 
KAM Plus
Data Engine (Kantronics)
PK-88, PK-232
DSP-232 
MFJ-1270x
MFJ-1278

AA4RE
F6FBB
MSYS
N0ARY
DXNET
Telpac/Winlink
W0RLI

KPC3 5.1
MFJ-1274
OpenBCM
JNOS
TNOS

•See http://www.outpostpm.org/bbs/ for...
•Updates to the list of supported BBSs
•Instructions on how to get your BBS supported

http://www.outpostpm.org/bbs/
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v2.2 Enhanced BBS Support  
Outpost Packet Message Manager

BBS setups
• BBSs

•BBS Name
•BBS Prompts
•BBS Commands
•BBS Path
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v2.2 Enhanced BBS Support
Outpost Packet Message Manager

Headers & Trailers
•Headers are captured and 
stored separately.

•Trailers are deleted (single 
line separator at message 
end)

View
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v2.1 KA-Node/Netrom Access
Outpost Packet Message Manager

BBS setups
• BBSs

•BBS Name
•BBS Prompts
•BBS Commands
•BBS Path

Notes...
• Direct:  from your station to the BBS
• Digipeat: one or more digipeater

stations between you and the BBS
• KA-Node/Netrom:  one or more 

nodes between you and the BBS



22 Outpost Packet Message Manager 2.2.0

v2.1 KA-Node/Netrom Access
An Example

The K6AB-1 BBS is accessible only through 2 Nodes:
1.  W6TDM-3, a BPQ Packet switch with 3 radio ports
2.  K6KP-7, a KA-Node 

Outpost
145.050

F6FBB BBS
223.660Mhz

K6KP-7

BPQ Switch
Port 1 = 145.050Mhz
Port 2 = 223.660Mhz
Port 3 = 440.000Mhz

KA-Node
223.660Mhz

K6AB-1W6TDM-3KN6PE

P
or

t 1 P
or

t 2 P
or

t 3

Outpost
145.050

F6FBB BBS
223.660Mhz

K6KP-7

BPQ Switch
Port 1 = 145.050Mhz
Port 2 = 223.660Mhz
Port 3 = 440.000Mhz

KA-Node
223.660Mhz

K6AB-1K6AB-1W6TDM-3W6TDM-3KN6PEKN6PE

P
or

t 1 P
or

t 2 P
or

t 3
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v2.1 KA-Node/Netrom Access
An Example

1st Node – BPQ Switch
1. Standard Setup for K6AB-1 BBS
2. Outpost (home) to W6TDM-3
3. When connected to the 1st node, 

we see “*** CONNECT”
4. From this node, we transmit on 

Port 2 to get to the 2nd node –
K6KP-7

Outpost
145.050

F6FBB BBS
223.660Mhz

K6KP-7

BPQ Switch
Port 1 = 145.050Mhz
Port 2 = 223.660Mhz
Port 3 = 440.000Mhz

KA-Node
223.660Mhz

K6AB-1W6TDM-3KN6PE

P
or

t 1 P
or

t 2 P
or

t 3

Outpost
145.050

F6FBB BBS
223.660Mhz

K6KP-7

BPQ Switch
Port 1 = 145.050Mhz
Port 2 = 223.660Mhz
Port 3 = 440.000Mhz

KA-Node
223.660Mhz

K6AB-1K6AB-1W6TDM-3W6TDM-3KN6PEKN6PE

P
or

t 1 P
or

t 2 P
or

t 3
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v2.1 KA-Node/Netrom Access
An Example

2nd Node – KA-Node
1. When connected to the 2nd node, 

we see “… Help ?”, essentially 
the Node Prompt

2. From this node, we transmit to 
get to the BBS… K6AB-7

3. Port number is 0 since there is no 
port choice

Outpost
145.050

F6FBB BBS
223.660Mhz

K6KP-7

BPQ Switch
Port 1 = 145.050Mhz
Port 2 = 223.660Mhz
Port 3 = 440.000Mhz

KA-Node
223.660Mhz

K6AB-1W6TDM-3KN6PE

P
or

t 1 P
or

t 2 P
or

t 3

Outpost
145.050

F6FBB BBS
223.660Mhz

K6KP-7

BPQ Switch
Port 1 = 145.050Mhz
Port 2 = 223.660Mhz
Port 3 = 440.000Mhz

KA-Node
223.660Mhz

K6AB-1K6AB-1W6TDM-3W6TDM-3KN6PEKN6PE

P
or

t 1 P
or

t 2 P
or

t 3
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v2.1 Tactical Calls
Outpost Packet Message Manager

Tactical Calls
• Definition: a call sign that

identifies a tactical location and is
operator-neutral allowing the
operators to change, without
having the assignment name 
change.

• Implemented by Outpost, not the
BBS

• Example: For the Santa Clara
County Hospital System, hospitals
are assigned Tactical Calls such as:
• 1MVECH  Mountain View El Camino Hospital
• 1PASMC  Palo Alto Stanford Medical Center
• 1SJVMC   San Jose Valley Medical Center
• 1SJGSH   San Jose Good Samaritan Hospital
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1CUEOC>W6SJC-1: <<C>>:
W6SJC-1>1CUEOC: <<UA>>:
W6SJC-1>1CUEOC: <<I00>>:
[FBB-7.04j-AB1FHMRX$]

Hello Jim,
Welcome to The San Jose EOC Mailbox

W6SJC >

1CUEOC>W6SJC-1: <<I01>>:
LM

W6SJC-1>1CUEOC: <<I11>>:
*** : Nothing found
*** : TO Field Filter is set to:- [ * ]

W6SJC >

1CUEOC>W6SJC-1: <<I12>>:
B

W6SJC-1>1CUEOC: <<I22>>:

73 Jim,

W6SJC-1>1CUEOC: <<D>>:
1CUEOC>W6SJC-1: <<I23>>:
StationID=KN6PE, TacCall=1CUEOC, Cupertino OES

1CUEOC>W6SJC-1: <<I33>>:

1CUEOC>W6SJC-1: <<I43>>:

1CUEOC>W6SJC-1: <<UA>>:

1CUEOC>W6SJC-1: <<C>>:
W6SJC-1>1CUEOC: <<UA>>:
W6SJC-1>1CUEOC: <<I00>>:
[FBB-7.04j-AB1FHMRX$]

Hello Jim,
Welcome to The San Jose EOC Mailbox

W6SJC >

1CUEOC>W6SJC-1: <<I01>>:
LM

W6SJC-1>1CUEOC: <<I11>>:
*** : Nothing found
*** : TO Field Filter is set to:- [ * ]

W6SJC >

1CUEOC>W6SJC-1: <<I12>>:
B

W6SJC-1>1CUEOC: <<I22>>:

73 Jim,

W6SJC-1>1CUEOC: <<D>>:
1CUEOC>W6SJC-1: <<I23>>:
StationID=KN6PE, TacCall=1CUEOC, Cupertino OES

1CUEOC>W6SJC-1: <<I33>>:

1CUEOC>W6SJC-1: <<I43>>:

1CUEOC>W6SJC-1: <<UA>>:

v2.1 Tactical Calls
Outpost Packet Message Manager

Tactical Calls
Notes
• Before using tactical a call, register the 
call sign with the BBS if required.

Is it legal? 
• AX.25 extended address field contains 
source & destination call sign.

• Outpost uses the TNC’s “my call” 
command to set the Tactical Call as 
the station identifier.

• The selected Tactical Call needs to be 
a sufficiently valid call sign to “fool” the 
BBS’s call sign checking logic.

• Outpost sends a “Legal Identifier 
String” that satisfies FCC Part 97.119.
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Overview
Outpost Packet Message Manager

How Outpost works
• You tell Outpost about…

• the type of Interface (Serial TNC, AGWPE, Telnet)
• the name of the BBS
• the path to get to the BBS (direct, digipeaters, KA/Netrom nodes)

• Outpost knows the TNC and BBS commands and their prompts

• Outpost automatically sequences what you would do manually…
• send commands to set up the TNC or interface
• send the commands to connect to the BBS
• look for prompts from the BBS, and 
• send the commands to send, list, read, or delete messages
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Exit the BBS,
Shut down the Interface

Initialize the Interface

Connect to the BBS

Send all messages
from Out Tray

If Private is set
• Retrieve List, Read, and 

Delete each message

If NTS is set,
• Retrieve List and Read 

each message

If Bulletins is set,
• Retrieve List, if don’t 

have it, read each msg

Send any message
delivery, read receipts

Process Bull, NTS deletes

Overview
Outpost Packet Message Manager

• Connect to the BBS
• Determines the BBS type
• Figures out the BBS prompts

• Send Messages
• Only send from the Out Tray to this BBS
• Messages must be “Sent” not “Saved”
• Once sent, message is moved to Sent Folder

• Retrieve Messages
• Depends on the Retrieve settings
• New messages are stored in the In Tray
• Depends on the “Keep on BBS” setting
• Bulletins are never deleted, except…
• NTS Messages are never deleted, except…

• Send Receipts
• Any pending Delivery and Read Receipts are 

sent back to the requester
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Special Message Handling
Outpost Packet Message Manager

Bulletins
To delete a bulletin off of the BBS
that you originated…

• Retrieve the bulletin from the BBS
• Open the message
• Press Expire
• On the next send/receive session, 
the bulletin will be deleted off of 
the BBS.
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Special Message Handling
Outpost Packet Message Manager

NTS Messages
• Retrieved NTS messages are not 
automatically deleted off of the BBS.

• To accept a message for servicing… 
• Retrieve the NTS message from 
the BBS

• Open the message
• Press Accept
• On the next send/receive session, 
the NTS message will be deleted 
off of the BBS.

Notes
• If you change your mind and do not plan to service the NTS message, it is 
common courtesy to post it back up on the BBS
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Survey of PBBSs
Supported by Outpost

KPC3+ On Price list; Single port, multi-user mailbox (v9.0, 6/2005)
KPC9612+ On Price list; Multi-port, multi-user mailbox (v9.0, 6/2005)
KAM-XL On Price list; All Mode, 2 Port, 3 data rates, single user mailbox
KPC3 Discontinued 1996, single user mailbox, replaced with KPC3+
KPC9612 Discontinued 1996, replaced with KPC9612+
KAM98 Discontinued 2005, replaced with KAM-XL
KAM+ Discontinued 1998
Data engine Discontinued, replaced with either KPC3+ or KPC9612+

Kantronics

PK-232 On Price list; All mode, single user mail drop

PK-88 Discontinued, single port TNC, 1200 baud packet 
DSP-232 On Price list; All mode, 2 port, single user mail drop

Time Wave

MFJ-1270A/B/C Discontinued, but firmware upgrades still offered for sale
MFJ-1278B Discontinued, but firmware upgrades still offered for sale

MFJ
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Survey of BBS Apps
Supported by Outpost

Telpac/Winlink Last update: 2006; Linux, Windows (.NET framework); message 
forwarding (compressed)

AA4RE Last update: 1999 (for Y2K); DOS; Turbo Pascal, Multi-connect 
Full service BBS, phone, server, call book support

N0ARY Last update: circa 1995; Sun workstation; innovative natural 
language parser for interacting with the user; internet gateway

MSYS Last update: ~1991; Multi connect full service BBS node; tcp/ip
support; last SID is [MSYS-1.20beta4-BFXM HI$] (beta release?)

DXNET Last update: ~unknown; DOS, Windows, Linux; C++; DX Cluster 
and BBS

F6FBB Last update: 2001; DOS, Windows, Linux; multi-port, Multi connect 
full service BBS; message forwarding (compressed)

W0RLI Last update: circa 1994; C; Full service BBS; requires DesqView
and 286/386.  Callbook with G8BPQ node. 
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Survey of BBS Apps
Outpost Support Pending

JNOS Last update: 2007; Linux, DOS, Windows, O/S2, MAC; BBS, IP 
router, Internet Gateway, Node, Telnet node… more

OpenBCM Last update: 2006; Linux, DOS, Windows; C++; amateur radio 
and citizen band (Europe) AX.25 BBS, AX.25 store and forward 
capabilities

TNOS Last Update: 2001; All BSD/POSIX platforms, Linux, Solaris, AIX,
Windows, open source; BBS, chat, other internet servers 



Outpost futures
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Under investigation
• Message Audit Reports
• Address book (Telpac driven, include distribution lists)
• Attachments Phase 1 (.txt, .uue)
• Emulation support for Linux, Mac

Futures 
• F2B Forwarding Protocol
• Multiple addressing for non-Telpac BBSs?
• Native support for Linux, Mac
• Others?



Need more information?
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•User Guide… www.outpostpm.org#documentation
• A complete description of all features, forms, fields, and controls in Outpost

•HOW-TO pages… www.outpostpm.org/howto.html
• Specific How-To’s for the most common tasks performed

•Application Notes… www.outpostpm.org#documentation
• Write-ups with more details on a specific topic.

•Troubleshooting page… 
www.outpostpm.org/troubleshooting.html

•Users group… 
http://groups.yahoo.com/group/outpostpacket/
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Background Information
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Messages
Outpost Packet Message Manager

•Creating Messages
• Direct Entry
• NTS Message Maker
• On-line Report Builder
• Cut-and-paste from other apps
• Import Text from a file

•Special Message Handling
• Bulletins
• NTS
• Telpac/Winlink messages
• Tactical Calls
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Creating Messages
Outpost Packet Message Manager

1. Direct entry
• Allows cursor placement within 

the text field
• Supports TAB characters 

(cntl-tab) thereby reducing 
character count

• Allows text files to be directly 
imported into the message form
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Creating Messages
Outpost Packet Message Manager

2. NTS Message Maker
• Step 1: Forms-based with field 

validity checking
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Creating Messages
Outpost Packet Message Manager

2. NTS Message Maker
• Step 1: Forms-based with field 

validity checking
• Step 2: Press Check; reformats  

the message per the NTS Packet 
message standard
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Creating Messages
Outpost Packet Message Manager

2. NTS Message Maker
• Step 1: Forms-based with field 

validity checking
• Step 2: Press Check; reformats  

the message per the agreed NTS 
Packet message standard

• Step 3: Saves the message to a 
message window; message type 
is NTS.  Press Send when ready.
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Creating Messages
Outpost Packet Message Manager

2. NTS Message Maker
• and ARL Messages… 

• Select the message Type… 
Routine or Emergency

• Select the message
• Provide any additional 

information
• Send the message as usual
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Creating Messages
Outpost Packet Message Manager Tag Description

= Prompt

/ comment Place a comment in the report

<D>, <date1> mm/dd/yy (5/21/04). 

<date2> dd-mmm-yyyy (21-May-2004)

<T>, <time> hh:mm (22:45)

<M>, <msg#> Message Number; from Report Settings

<C>, <call> Call, as entered at the Station ID form

<name> Name, as entered at the Station ID form

<bbs> BBS name; current BBS

<subj>text Places “text” on subject line

<org> Organization; from Report Settings

<city> City name; from Report Settings

<county> County name; from Report Settings

<state> State name, 2 char; from Report Settings

<province> Province name, 2 char; instead of state

<tacloc> Tactical Location; from Report Settings

<tacid> Tactical ID, 3 char; from Report Settings

<text1, 2, 3> User defined text; from Report Settings

3. On-line Report Builder
• Step 1: Set up the Report 

Settings (described previously)
• Step 2: Understand the list of 

Report <tags>

NOTE: there are some report 
variables that have to methods 
for representing them
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Creating Messages
Outpost Packet Message Manager

3. On-line Report Builder
• Step 1: Set up the Report 

Settings (Tools > Report 
Settings)

• Step 2: Collect the list of Report 
tags, most in the format “<tag>”

• Step 3: Develop the report 
template, save as a .txt file.
NOTE: see the use of 
comments (/), <tags>, and 
prompts (=) 
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Creating Messages
Outpost Packet Message Manager

3. On-line Report Builder
• Step 1: Set up the Report Settings

(Tools > Report Settings)
• Step 2: Collect the list of Report 

tags, most in the format “<tag>”
• Step 3: Develop the report

template, save as a .txt file.  
• Step 4: From a new message

form, “File > Open a Report” and
choose a report template.
NOTE: Subject line is updated,
<tags> are replaced, and cursor is
positioned at the first prompt. 

• Press cntl-Tab or left-mouse to progress to the next prompt.
• Press “File > Clear Remaining Prompts” for any unfilled prompts
• Press Send when done.
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Creating Messages
Outpost Packet Message Manager

4. Cut-and-Paste from
other apps

• From Excel, highlight the 
fields to be copied, then paste 
into an Outpost message.

• At the receiving station, 
highlight and copy the 
message, then paste back 
into Excel.

• Tabs are preserved so the 
message can be pasted back 
into another spreadsheet.
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Creating Messages
Outpost Packet Message Manager

5. Import text from a file
• Open a new message
• File > Open a file
• Select the text file, press OK
• Full in the Destination and 

Subject.
• Press Send when done.
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Tools and Controls 
Outpost Packet Message Manager

Interactive Packet 
Window

• Programs to manually interact 
with the TNC (serial only) and 
BBS by

• AGWPE
• Telnet
• Serial

• Logging controls
• Cut-and-paste clipboard support 

into and out of the IPW window
• use the Edit control on the 

menu
• cntl-c gets the TNC’s attention

• Directly create an Outpost 
message from highlighted IPW 
text
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